Google Sheets

Google Web Applications

Google web applications are a set of web pages that perform certain
standard tasks, such as email, word processing and spreadsheets. These
are different from applications you download and run on your computer
since they are all done in a web browser.

Google App Type Programs That Do Similar Tasks

Gmail Email Microsoft Outlook, AOL, Yahoo Mail

Google Docs Word Processing Microsoft Word, Apple Pages,
LibraOffice

Google Sheets Spreadsheet Microsoft Excel, Apple Numbers
LibraOffice Calc

Google Calendar Calendar Microsoft Outlook
Google Contacts Contacts Apple Contacts, Microsoft Contact
Organizer

Google also makes a browser program called Chrome which must be
installed on your device (if it does not come with it). Other popular browser
programs are Safari, Firefox, Microsoft Edge and Opera.
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Google Sheets

Google Sheets is a simple and powerful spreadsheet application that has
similar features to the other spreadsheet programs. It does not have some
of their advanced features but probably fine for most users. A spreadsheet
program is used to store rows and columns of data and optionally do
calculations on them.

It has the advantage that your documents are kept on the Cloud (Internet)
on Google computers and are associated with your Google Account. That
means that you have to sign up for a Google account to use if you don’t
already have one. It also means you can access your documents
anywhere in the world on any device that connects to the Internet. You
simply have to log into your Google account to access them.

To access Google Sheets, you can go to the Google Sheets website

https://sheets.google.com

This will redirect you to this web address:

https://docs.google.com/spreadsheets/u/0/

You can also click the Google Apps icon on Gmail which is in the upper
right part of the window and looks like a three by three square of dots:
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https://sheets.google.com/
https://docs.google.com/spreadsheets/u/0/

If you use the Chrome browser, the three by three “tic tac toe” board is
colored and the first button on your Bookmark Toolbar:

® ® o Goog

== Apps M Gmail

When you click on one of these buttons, it will bring up a popup window
with the Google Apps:

Account Contacts Hangouts

Search Maps YouTube
News

- M

Play Gmail
] & B
Drive Calendar Translate

2 O M

David Taenzer 3 August 2020



If scroll down, you will see the Google Sheets button:

Books Blogger Keep
2i E ~
Classroom th Collections
. |
ZE]
Sheets Slides Jamboard

O

Arts and C..  Google Ads Podcasts

c\ ‘e

More from Google

This will open up Google Sheets in the current window or a new browser
tab depending on how your browser preferences are set up.

You can create lots of useful documents with this tool.
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Creating a Spreadsheet

When you first go to the Google Sheets web page, it shows you various
templates you can use to start a new document or you can create a blank

spreadsheet:

= [H sheets  Q searcn 5 @

Start a new spreadsheet Template gallery 2

|_

Blank To-do list Annual budget Monthly budget

Tobe -

Today Owned by anyone ~ Last opened by me H Az [

Food Log me 417 PM

u 2020 SPCO Virtual Lunch-Learn Progr... 2%, SeniorPla. 7:15AM

Below the templates are your recent spreadsheets that you have edited.
There is also a search box at the top (next to the magnifying glass) to
search for a specific document by name.
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Spreadsheet Cells, Rows, Columns

A spreadsheet is a set of data cells arranged in rows and columns.
Columns are labeled with letters (A, B, C, etc.)
Rows are labeled with numbers (1, 2, 3, etc.)
For example
D4

refers to row 4 of column D

Untitled spreadsheet
File Edit View Insert Format Data Tools Add-ons Help

e N - 100% ~ $§ % .0 .00 123~ Default (A.. ~

D4\

vem [ | G| ma | =
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Cells can contain data (numbers, text, dates) or formulas.

Formula cells have values that start with the equals character (=). If you
want to enter text that starts with the equals character, put a single quote
before the text, e.g.

‘= some text here

To select a column, click on the header (the letter above the column)

Untitled spreadsheet % &)
File Edit View Insert Format Data Tools Add-ons Help Lastedit..

~ o~ & P 100% v § % .0 .00 123w Default(Ar.. v 10  ~

this is a lot of

text in one cell C”Ck here
which does not
fiit

o e o an | W

This selects all the cells in a column and they display in light blue.
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To select a row click on the row number to the left of the cells:

Untitled spreadsheet % &)
File Edit View Insert Format Data Tools Add-ons Help Lastedit..
~ ~ = P 100% v § % .0 .00 123~  Default(Ari. v 10 v e

this is a lot of text in one cell which does not fit

click here : c 0 E

this is a lot of
text in one cell
which does not
fit

You can select a rectangle of adjacent cells by dragging across them:

Untitled spreadsheet ¢ e
File Edit View Insert Format Data Tools Add-ons Help Lastedit..

~ o~ P 100% v $§ % .0_ .00 123~  Default (Ari.. v 10 v

this is a lot of text in one cell which does not fit

A B Cc D £

1

thisisalo
2 textino |

which does not

fit
3
- K to here
5

|

6
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Google Sheets Menu

One of the most confusing things about using Google web applications is
that many have a separate menu bar that is inside the browser window. In
Google Sheets, this is what it looks like:

@ Safari File Edit View History Bookmarks Develop Window Help

[ ] @ < -Io docs.google.com/spreadsheets/d/1G7TsiflaYFNEgLPOnhKDWGLZnnTh

browser menu

Untitled spreadsheet E
File Edit View Insert Format Data Tools Add-ons Help

~ @ P 100% ~ § % 0 .00 123~ Default (Ari.. ~ 10 v

Google Sheets menu

- B C D E

I

T

The menu on the top of the screen is the menu for the current program (the
Safari browser in this case). The menu in the browser window under the
spreadsheet title is the Google Sheets menu. They look very similar, so
please don’t be confused by this. Notice they both have menus with names
like “File”, “Edit”, “View” and “Help”.

Probably the hardest thing to learn about using Google Sheets is that there
is a completely different menu that you use for the spreadsheet functions.
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The File menu has many options. One that is very useful is “Download”

Untitled spreadsheet ¢ O
File Edit View Insert Format Data Tools Add-ons Help
e~ Share 6 .0 .00 123~ Default (Ari.. ~ 10 v | ses
New > C D E F
1 |: Open %0
3
3 Import
4 Make a copy
5
6
-
HJ Download > Microsoft Excel (.xIsx)
10 version histon OpenDocument format (.ods)
L PDF document (.pd
12 Rename ] - pedmentipdi)
13 e Web page (.html, zipped)
= : to tras
- Comma-separated values (.csv, current sheet)
5
16 Publish to the web Tab-separated values (.tsvy, current sheet)

17
18
19
20

21 & Print %P

Spreadsheet settings

This lets you save the spreadsheet on your computer in a variety of
different formats. The advantage of PDF files is that they look the same on
all devices and most devices are set up to view PDF files without additional
software.

David Taenzer 10 August 2020



The Edit menu has normal spreadsheet editing tasks like Copy, Paste, Find
and Replace.

Untitled spreadsheet %
File Edit View Insert Format Data Tools

rxﬂ v~ Undo 38z

~ Redo #Y
A

! K Cut X
i I0 Copy 3%C
4 [*] Paste BV
Z Paste special >
7
8 Find and replace 8 +Shift+H
9
1:] Delete values
12 Delete row 1
13 Delete column A
15 Delete cells and shift up
1? Delete cells and shift left
18
19 Clear notes
i‘] Remove checkboxes

- |
o
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This shows the keyboard shortcuts you can use (e.g. Command / C for
copy on the Mac). This is normally Control / C on a PC.

The View menu lets you control what is displayed:

Untitled spreadsheet %
File Edit View Insert Format Data Tools Add-ons Help

> ren
K~ Freeze NO rows
- 1 row
A v Gridlines
2 rows

1 Protected ranges

2 Up to current row (4)
3
G v Formula bar
. No columns
5 Show formulas Ctri+ -
6 1 column
7
- 2 columns
g Zoom >

Up to current column (A)
10

Full screen
12

It has a Freeze option to freeze header rows so you can scroll through the
document and these rows will stay in place. You can also freeze columns if
the document is very wide.
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The Insert menu has lots of useful features:

Untitled spreadsheet ¢
File Edit View

—

W o~ AWM

NN b | oo | b | b | ond | i | o | | | i
Wi =S O O o~ ah h s N =0

i

Display a menu

I

David Taenzer

Sheet1

Insert Format

Row above

Row below

Column left

Column right

Cells and shift down

Cells and shift right

[1:] Chart

M Image

> Function
D Insert link
Checkbox
El Comment

Note

New sheet

13

K

#8+0ption+M

Shift+F2

Shift+F11

Data Tools Add-or

ult |
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You can insert extra rows and columns. You can also access do this by
selecting a cell, row or column and clicking the right mouse button to see
the context sensitive menu.

Untitled spreadsheet ¢

File Edit View Insert Format Data 1

0 Copy 3C
[*] Paste RV
1
2 Paste special >
3
B Insert row
5
- Insert column
7 - Insert cells B
s right
g C’!Ck Delete row
10 «
1 in Ce" Delete column
12
Delete cells B
13
14
15 D |nsert link 3K
16 Get link to this cell
17
18
19 Define named range
20 Protect range
21
22
- Comment
& 38 +0Option+M
Insert note
+ =

Display a menu
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The Format menu also has lots of features.

Untitled spreadsheet
File Edit View Insert Format Data Tools Add-ons Help

—~ ~ | P 100%1 Theme v

A B Number >
1
2 B Bold 6B
3

I ltalic #l
4 I
| |

5 U Underline U
6
- 5 Strikethrough 38 +Shift+X
8
9 Font size >
10
1" Align >
12
13 Merge cells >
14 Text wrapping >
15
16 Text rotation >
17
18 Conditional formatting
19
20 Alternating colors
21
22 Y Clear formatting a8\
23
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For example, if | type in a lot of text in a cell:

Untitled spreadsheet ¢ &)
File Edit View Insert Format Data Tools Add-ons Help Lastedit..
“ ~ = P 100% v § % .0 .00 123~  Default (Ari. v 10 v e

this is a lot of text in one cell which does not fit
A B - D E

2 this is a lot of tex.l in one cell which does not fit

| can use the Format / Text Wrapping / Wrap option to fix this:

Untitled spreadsheet #% & ®
File Edit View Insert Format Data Tools Add-ons Help Lastedit..

el - 100%g#~ " ! Theme r 10 -
= T

this is a lot of text in one cell v

A B Number > E e

1
2 |thisis a lot of te;l. in one cellwhi B Bold 3*B
3

I ltalic |
4
5 U Underline #*U
6
- 5 Strikethrough 3 +Shift+X
8
9 Font size >
10
1 Align >
12
13 Merge cells =
14 .
= / Text wrapping > < Overflaw
16 Text rotation > Wrap
17 ” po"

i

18 Conditional formatting P
19
20 Alternating colors
21
22 . Clear formatting 8\
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This will wrap the text in the cell:

Untitled spreadsheet % &
File Edit View Insert Format Data Tools Add-ons Help Lastedit..

~ ~ g T 100% v $§ % .0 .00 123v Default(Ari. v 10 v .

this is a lot of text in one cell which does not fit

) B C D E

this is a lot of
text in one cell
which does not
fit

Any of the formatting options can be applied to a cell, row(s), column(s) or
a rectangle of cells.
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The Data menu has a number of useful functions:

Untitled spreadsheet % &
File Edit View Insert Format Data Tools Add-ons Help Lastedit.

Y~ o P 100% v $1.q Sort sheet by columnC,A—2Z ~

Sort sheet by columnC, Z — A

A B

: Sort range

this is a lot of
, textinone cell Y Create a filter

which does not

fit Filter views =
3 — -

——— = Slicer New
4
5
6 Data validation
4 Pivot table
8
g Randomi ange
10
Named ranges

11
12 Protected sheets and ranges
13
14 Split text to columns
15
16 Remove duplicates
L Trim whitespace
18
19 4 .
20 Group Option+Shift+—

21 Ungroup

This lets you sort the data in the spreadsheet by one or more columns
along with other functions like splitting text into multiple columns.
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To explain some of the options so far, | have entered some simple
checkbook data into a blank spreadsheet:

Untitled spreadsheet % &

File Edit View Insert Format Data Tools Add-ons Help Lastedit was seconds ag

~ ~ & T 100% v $§ % 0 00123+ Defat(hr. ~ 10 + B I & A
A B Cc D E F

1 Check # Date Payed To Amount

2 101 8/1/2020 Electric Company 105.2

3 102 8/1/2020 Sue Smith 50

4 103 8/3/2020 Acme Grocers 163.25

5 104 8/4/2020 Gary Jones 25

6 105 8/4/2020 Gas Company 45.78

7 I

The first thing | will do is highlight the first line and format it as bold:

Untitled spreadsheet ¥ &

File Edit View Insert Format Data Tools Add-ons Help Lastedit was 2 minutes ago

hﬂﬁ‘r'wc%-ﬂ Theme 0 - B I & A
(Z)then click here
A B

Number > E F

Check # Date Pay
: 101 8/1/2020 Elec B Bold &
3 102 8/1/2020 Sue ,
4 103 8/3/2020 Acn " lrlig Nl (3) then C”Ck
5 104 8/4/2020 Gar U Underline #EU h
6 105 8/4/2020 Gas
- - 5 Strikethrough 38+Shift+X ére
' (1) click here
9 Font size >
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The spreadsheet now looks like this:

Untitled spreadsheet s+ & &

File Edit View Insert Format Data Tools Add-ons Help Lastedit was seconds ag

~ o~ & P 100% » § % O 00123+ Defaut(d. ~ 10 -+ B I & A
A B c D E F

1 Check # Date Payed To Amount

2 101 8/1/2020 Electric Company 105.2

3 102 8/1/2020 Sue Smith 50

1 103 8/3/2020 Acme Grocers 153.25

5 104 8/4/2020 Gary Jones 25

6 105 8/4/2020 Gas Company 45.78

=

To adjust the columns to the width of the data, | can move my cursor to the
small vertical line in the header row between the columns and drag left or
right:

Untitled spreadsheet ¢ &
File Edit View Insert Format Data Tools Add-ons Help Lastedit)

~ o~ @& P 100% v $ % 0 00 123+ Default(Ar. v 10 i

‘ click here and drag Ieft or nght

1 Check # Date Payed To Amount

2 101 8/1/2020 Electric Company 105.2
3 102 8/1/2020 Sue Smith 50
4 103 8/3/2020 Acme Grocers 163.25
5 104 8/4/2020 Gary Jones 25
6 105 8/4/2020 Gas Company 45.78
7

If you double click on this spot, the column adjusts automatically to the
width of the data in it.
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If I do that for all four columns, the spreadsheet looks like this:

Untitled spreadsheet +¢ o)
File Edit View Insert Format Data Tools Add-ons Help L:

e~ o~ P 100 ~ § % .0 .00 123+  Default(Ar. -~ 10

i B c D E F

1 Check# Date Payed To Amount
2 101 8/1/2020 Electric Company 105.2
3 102 8/1/2020 Sue Smith 50
R 103 8/3/2020 Acme Grocers 153.25
5 104 8/4/2020 Gary Jones 25
6 105 8/4/2020 Gas Company 45.78
7
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| can select Column A and change it to be center aligned:

Untitled spreadsheet &+ B &
File Edit View Insert Format Data Tools Add-ons Help Lastedit was seconds ago

SN - 1 100%l Theme 10 - B I & i

Check 2
B c Number L G H

1 Check #|Date Payed To
2 101|8/1/2020 ElectricCor B Bold B
3 102 | 8/1/2020 Sue Smith ;
4 103| 8/3/2020 Acme Groce % A1 el
5 104 | 8/4/2020 Gary Jones |J Underline 3EU
6 105 | 8/4/2020 Gas Compal : ;
7 S Strikethrough 38 +Shift+X
8
9 Font size > 3
10
1 ;
= Align "1 v Let 38+ Shift+L
13 Marge cells £ Center 38 +Shift+E
14 .
& Text wrapping > Right se+Shift+R
16 Text rotation >
17 Top
:: Conditional formatting Middle
20 Alternating colors & ‘Bottom
21
22 . Clear formatting e\
23

A B C D

Check # Date Payed To Amount

101 8/1/2020 Electric Company  105.2

102  8/1/2020 Sue Smith 50

103  8/3/2020 Acme Grocers 153.25

104  8/4/2020 Gary Jones 25

105  8/4/2020 Gas Company 45.78
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Finally, | can format column D to be currency by clicking on the column
heading:

Amount

Check # Date Payed To Amount
101 8/1/2020 Electric Company 105.2
102  8/1/2020 Sue Smith 50
103  8/3/2020 Acme Grocers 153.25
104  8/4/2020 Gary Jones 25
105  8/4/2020 Gas Company 45.78
Untitled spreadsheet &% = & E

File Edit View Insert Format Data Tools Add-ons Help Lastedit was 3 minutes ago

naﬁ?!noaﬂ Theme ° - B IS A & M@

Amount
A B c Number > v Automatic I

1 Check # Date Payed Plain text
2 101 812020 Elegfcor B Bold #®B ks
3 102 8/1/2020 Sue Smith .
4 | 103 8302020 Acme Groce 2 "2NC i Number 1,000.12
5 104  8/4/2020 Gary Jones U Underline #U Percent 10.12%
6 105  8/4/2020 Gas Compal ) )
7 5 Strikethrough #+Shift+X Scientific 1.01E+03
8
9 Font size " Accounting $ (1,000.12)
10
It Align . Financial (1,000.12)
12
- MFeGalis ] Currency $1,000.12
14 Textwispping r Currency (rounded) $1,000
15
16 Text rotation " Date 9/26/2008
17
18 Conditional formatting Dme Aoty
2 . Datetime  9/26/2008 15:59:00
0 Alternating colors
" Duration 24:01:00
2 ‘W Clear formatting 38\
3 #,#4#0 1,235
4
5 3:59 PM
6 Fri, Sep 26, 2008
7

More Formats >
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Our spreadsheet now looks like this:

A B c D

1 Check # Date Payed To Amount
2 101 8/1/2020 Electric Company $105.20
3 102  8/1/2020 Sue Smith $50.00
4 103  8/3/2020 Acme Grocers $163.25
5 104 8/4/2020 Gary Jones $25.00
6 105 8/4/2020 Gas Company $45.78
7

We can sort this by Amount if we like by selecting the cells:

A B C D

1 Check # Date Payed To Amount
2 101 8/1/2020 Electric Company $105.20
3 102  8/1/2020 Sue Smith $50.00
4 103  8/3/2020 Acme Grocers $153.25
5 104  8/4/2020 Gary Jones $25.00
6 105  8/4/2020 Gas Company $45.?B.
7
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If we choose the Sort Range function on the Data menu:

Untitled spreadsheet ¥ @ &

File Edit View Insert Format Data Tools Add-ons Help Lasteditwa

e~ o~ o P 100% - .0_ Sort sheet by column A, A — Z B
Check # Sort sheet by column A, Z — A
A 8 C G

| Check#|Date  PayedTo Am Sort range by column A, A — Z
2 101 8/1/2020 Electric Company $1(

3 102 8/1/2020 Sue Smith ¢t Sortrange by column A, Z — A
4 103  8/3/2020 Acme Grocers $1¢f

5 104  8/4/2020 Gary Jones

6

7

‘ Sort range
105  8/4/2020 Gas Com $4

Y Create a filter

This window pops up:

Sort range from A1to D6 X

|:| Data has header row

Sortby ColumnA ~ ®A-Z Z—>A

Add another sort column
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We can click the Data has header row checkbox and change use the Sort
by menu to select the Amount column (D):

Sort range from A1to D6

Data has header row

Sortby Amount ~ ®A-2Z

Add another sort column

Cancel

And click the green Sort button to sort the data:

A B C D

1 Check # Date Payed To Amount
2 104 8/4/2020 Gary Jones $25.00
3 105  8/4/2020 Gas Company $45.78
4 102  8/1/2020 Sue Smith $50.00
5 101 8/1/2020 Electric Company $105.20
6 103 8/3/2020 Acme Grocers $1 53.25.
$

We can sort by any column using this technique. You can also add more
columns to sort by one and then the other using the “Add another sort
column” button
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Finally, we can add a new row with the sum of all the amounts. We start by
selecting the Amount data cells by dragging from D2 to D6:

105.2
A B c D
1 Check # Date Payed To Amount
2 101 8/1/2020 Electric Company | $105.20
3 102 8/1/2020 Sue Smith $50.00
4 103 8/3/2020 Acme Grocers $153.25
5 104 8/4/2020 Gary Jones $25.00
6 105 8/4/2020 Gas Company $45.?B.
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Then select Insert / Function / SUM menu item:

spreaasneet iy 1 o

View

P

Insert Format Data Tools Add-ons Help Lastedit was 3 minutes

5 Rows above ault (A... ~ 10 * B JT 5

5 Rows below

Pa Column left
J20 Ele
120 Su Column right
120 Ac
)20 Ga Cells and shift down
)20 Ga )
Cells and shift right
[i] Chart
M Image (] >
E® Drawing
E Form
” > Function B
GO Insert link #K
Checkbox
Ed Comment 8 +0ption+M
Note Shift+F2
New sheet Shift+F11
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The spreadsheet now looks like this:

=SUM( )

A B C D
1 Check # Date Payed To Amount
2 101 8/1/2020 Electric Company : $105.20
3 102  8/1/2020 Sue Smith i $50.00
4 103 8/3/2020 Acme Grocers $153.25
5 104  8/4/2020 Gary Jones ®28 NN
6 105  8/4/2020 Gas Company  /2-23
7 Ell=sum(

Hit the Return key to see:

A B C D
1 Check # Date Payed To Amount
2 101 8/1/2020 Electric Company $105.20
3 102 8/1/2020 Sue Smith $50.00
4 103 8/3/2020 Acme Grocers $153.25
5 104 8/4/2020 Gary Jones $25.00
6 105  8/4/2020 Gas Company $45.78
7 $379.23
£ —

We can then add a TOTAL title in column C of row 8 and make it bold:
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TOTAL

A B C D
1 Check # Date Payed To Amount
2 101 8/1/2020 Electric Company $105.20
3 102  8/1/2020 Sue Smith $50.00
4 103 8/3/2020 Acme Grocers $153.25
5 104  8/4/2020 Gary Jones $25.00
6 105 8/4/2020 Gas Company $45.78
7 TOTAL | $379.23

There are many other functions available in the Insert / Function menu. All
functions start with the equals character instead of text or a number, e.g.

=SUM(D2:D6)
=SUM( ) «
A B C D

1 Check # Date Payed To Amount
2 101 8/1/2020 Electric Company $105.20
3 102 8/1/2020 Sue Smith $50.00
4 103 8/3/2020 Acme Grocers $153.25
5 104 8/4/2020 Gary Jones $25.00
6 105 8/4/2020 Gas Company $45.78
7

TOTAL $379.2 3.|

The “D2” refers to column D, row 2 and the D6 is column D row 6. The
colon character between them means all cells between D2 and D6.

There are many other features you can use but this should be enough for
you to give it a try.
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